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Introduction to this tutorial

In the tutorial called Building an RPG e-business application, you learned how to
create an e-business RPG customer inquiry application. When you ran your Web
RPG application a 'new” Web customer inquiry page opened in the workbench
Web browser. You then entered a customer number and clicked the submit button.
The customer details from a DB2/400 database appeared in the workbench Web
browser.

In this tutorial, you will learn how to display a list of customers, display the
details for each selected customer and then update selected customer information.
You will learn how to use Page Designer to create a new customer list input page
from a subfile. You will then learn how to link this new page to the customer
inquiry page that you built in the previous tutorial. Then you will learn how to
create new output pages (update record and update complete) using the Web
Interaction wizard. You will also learn how to link these pages using the Web
interaction wizard. Finally you will learn how to test your new and updated input
and output pages in your existing e-business RPG customer inquiry application.

Note: Because this is an advanced tutorial, the instructions do not take you
through each step to build a Web interface for a subfile, but outline the
development steps taken to create such an interface.

Tutorial purpose:
Before you begin, take a minute to read the learning objectives for the
tutorial.

Length of time:
This tutorial takes approximately 1.0 hour to complete.

Modules:
Work on the modules in sequence. The pictures in the modules show
similar tasks. Some of the names and icons may be different from the
environment you will be working with when you complete the modules.

Prerequisites
You should also learn about the prerequisite knowledge for the tutorial
before beginning. This section describes the type of knowledge you need to
already have to fully benefit from this tutorial.

Learning objectives

In this tutorial, you will create a new input page to view a list of customers
(custList.jsp) and use an existing output page (resultjsp) to create new output
pages to update customer records and confirm updates were completed on the
iSeries " (custDispUpdateResults.jsp and custDoUpdateResults.jsp) for your
existing e-business customer inquiry application. While creating these pages, you
will learn how to use the iSeries wizards in Development Studio Client to link
pages together to form an application with multiple Web interactions. You will
then learn how to run the updated customer inquiry application in the
WebSphere® Test Environment that is part of Development Studio Client.

The tutorial is broken into five modules, each with their own specific learning
objectives. You can choose to complete all modules, or you can choose to complete
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only a few, depending on your own learning goals. Each module is composed of
several exercises. These exercises must be completed in order to successfully
achieve the module’s goals.

The first module, Reviewing the Web customer inquiry application, shows you the
completed customer inquiry application that you will built in the tutorial called
Building an e-business RPG application. You will then see how this application
changes with the updates you will make working through this tutorial.

The second module, Creating the customer list input page, helps you learn how to
use Page Designer to create a Web input page of a subfile. This new input page
will pass the customer number back to the inquiry page. You also learn how to
modify the inquiry page by adding a link (Find button) that will open the
customer list page.

The third module, Adding the iSeries program to your Web application explains
how to select the RPG service program to handle the Web interaction you created
in the first module.

The fourth module, Creating the customer update output page, helps you learn
how to create an output page using the Web Interaction wizard. This is the page
that shows the customer information you can update.

The fifth module, Creating the update complete output page, helps you learn how
to create another output page using the Web Interaction wizard. This is the page
that shows the customer record was updated on the iSeries.

The sixth module, Running the Web application explains how to run the updated
Web application in the WebSphere Test Environment.

Be sure to read about the Prerequisite knowledge for the tutorial before beginning.
This section describes the type of knowledge you need to already have to fully
benefit from this tutorial.

Prerequisite knowledge

vi

In order to complete this tutorial end to end, you should already completed the
tutorial called Building an RPG e-business application and have working
knowledge of the following:

* Basic Microsoft® Windows® operations such as working with the desktop and
basic mouse operations such as opening folders and performing drag-and-drop
operations.

* How Web applications work.

* How to use a browser to navigate the Internet.

It is also useful, but not necessary, for you to have basic knowledge of the
following:

« HTML

* Servlets and Java'" Server Pages (to understand the generated output of the Web
Interaction wizard)

If you do not have current knowledge of these technologies and concepts, you

might be interested in learning more about these after you complete this tutorial.
You can find some additional information on these topics in the Help system that
is part of WebSphere Development Studio Client for iSeries. There are also plenty
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of resources on the Internet at our product Web page
http:/ /www.ibm.com/software /awdtools/iseries.

When you are ready to begin, start with Module 1: Creating the customer list page.

Introduction to this tutorial Vi1
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Chapter 1. Module 1: Reviewing the existing RPG e-business
application

In this module, you will review the existing RPG e-business application that you
built in the tutorial called Building an e-business RPG application. You will then
see what this application will look like when you have completed this tutorial.

In order to gain a introductory understanding of the customer inquiry application
that you will add on to in this tutorial, there are several steps you will need to
learn about and follow:

* Describe the Web customer inquiry application
* Describe the enhanced Web customer inquiry application

In order to accomplish these learning objectives, there are several steps that are
involved, including:

Exercise 1.1: Reviewing the Web customer inquiry application
Exercise 1.2: Introducing the Web customer inquiry application enhancement

The exercises in this module must be completed in order. Start with Exercise 1.1
when you are ready to begin.

Length of time:
This module will take approximately 10 minutes to complete.

Exercise 1.1: Reviewing the Web customer inquiry application

In the tutorial called Building an e-business RPG application you created a simple
e-business customer inquiry application that uses a Web-based front end to
communicate with RPG business logic residing on an iSeries server. You created a
representation of a Web interaction in a Web diagram. You then invoked the Web
Interaction wizard to create the input and output pages and to create the servlet to
invoke the RPG program or service program to get data from the iSeries database.
Next you added this RPG program or service program to the Web application.
Finally you tested the application in the local test environment on your
workstation. You also created an informative error page for when a customer
entered an incorrect customer number.

Here is what the finished e-business customer inquiry application looked like.
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After the WebSphere server started, your Web application Customer Inquiry input
page (inquiry,jsp) displayed in the workbench browser:

+ ] Welcome m-& x |

Ihttp:,l',l'lclcahclst:QDBDIwintlabxx,l'hquiy.isp ﬂ °| oo @

Customer Inquiry

Enter customer number; 0010100
Reset

Done I

When you enter a customer number and click the Submit push button, the
Customer Details output page (result.jsp) appears:

+ ] Welcome m: X |

Ihttp:,l',l'lclcahclst:QJJSD,I‘wintlabxx.fl:ustlnquiry.do ﬂ -] | F o5

Customer Details
Customer Number: Q010100

Customer Name: Meridien Electronics Limited
Representative Number: 43443

Contact: Alfredo Bayonne

FPhone Number: 206-865-4027

Fax Number: 206-865-4037

Address: 10423 S E. 30th Place

City: Bellevue, WA

Country: USA.

Zip: 98007

Submit | Reset
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Next, you clicked the Back button in the browser to return to the Customer Inquiry
input page. Here you entered an incorrect customer number and clicked Submit.

T |

|http:,f.fhcall'mt:QOBGIMntIabxx.finquirv.jsp j > | oo

Customer Inquiry

Enter customer number: {9999
Reset

Done

An error message appeared.

|http:.f.fbcalhost:QOBDIMntIabxinmuiry.jsp j ° S @ @

Customer Inquiry
Enter customer number; d| Customer number 9 not valid

Reset

—

You then added a new output error page to improve the message information so
that if a wrong customer number was entered,

Ihttp:,l',l'lclcahclst:‘B'EIBIJ,l'MntHJxx,l'i'uuiy.isp j Q<= @ @“? = | D
= |

Customer Inquiry

Enter customer number: 9999 _
Reset
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an error page opened instead of a message.

I http: fflocalhast ;9080 wintlabix fcustInguiry.do j =20 @“? = | D
Sorry, there iz no record for that customer number,
Please check the number and try agan

Done

Exercise 1.2: Introducing the enhanced Web application

4

By the end of this tutorial you will have enhanced the Web customer inquiry
application. You will invoke the Web Interaction wizard to first create a new input
page to view a list of customers (custList.jsp). Next you will add an iSeries RPG
service program to handle this Web interaction that you just created. Then you will
invoke the Web Interaction wizard to use the existing output page (result.jsp) to
create new output pages to update customer records and confirm updates were
completed on the iSeries (custDispUpdateResults.jsp and custDoUpdateResults.jsp).
You will then run the application in the local test environment on your
workstation. You will also create an informative error page if there is an error
during the update of a customer record.

Here is the completed e-business customer inquiry application.
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This is the Customer Inquiry input page.

mr x

Ihttp:,l',l'locahost:Sl]SD,l'Mntlebxx,l'i'iquiy.isp L’ (> | & o @ €§3 = | i
4l
Enter customer number:
-
Dane I

You click the Find link. The Customer List page opens:

B <

Ihttp:,l',l'locahost:QUSDIwintlabxx,l'wcl‘du?wclhidden=action_20F55625&j (] | = @ 6§9 i | i

Customer List -
¥ 2 g2 B | [ Select Action— | [Go]
Select Custorner Number Customer Mame ' Customer Phone b
® 0010100 Meridien Electronics Limited ‘206-865-402?
© 0010200 Rovyal Hardware Supplies 905-619-2045
© 0010300 Webster Appliances 619-549-5212
© 0010400 ProLine Building Supplies 905-403-4055
© 0010700 Universal Communications Ltd. 415-545-5055
© 0010800 Baker Electronics 818-715-2045
© 0010900 Village Telephone 707-367-4530
© 0011100 BelAir Communications incorp.  914-765-8021
© 0011300 Burnham Trading Inc 613-225-0753
© 0011400 Calderone Imports 407-392-7077
Page 10f8/ b | [1 |Go| | Total 71 Filtered: 71 Displayed: 10 Sele

| Get Customer Number |

v

4| |

ILI

|

You select the first entry on the list and then click the Get Customer Number
button. You return to the Customer Inquiry page with the customer number

Chapter 1. Module 1: Reviewing the existing RPG e-business application
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entered into the customer number field.

Ihttp:,l',l'localhost:9]8U,l‘wintlabxx,l‘getCustomerNumber.do?displav=Get- ﬂ (> ] | D @ Q@ a | i

Enter custormer number: 00010

| Submit | Reset

Cone

Next you click the Submit button. The Customer details page opens showing the
details of the selected customer.

X ]
Ihttp:,l',l'locahost:9[]801'wintlabxx,p'custlnquiry.dU j (] | = @ 6§9 i | i
=

Customer Details
Customer Number: 0010100

Customer Name: Meridien Electronics Limited
Representative Number, 43443

Contact. Alfredo Bayonne

Phone Mumber: 206-865-4027

Fax Mumber: 206-865-4037

Address: 10423 SE. 30th Place

City: Bellevue, VWA

Country: S A

Zip:

| Update Customer Record |
Back to Custorner Inguiry

http:f flacalhost: 9080/ wintlabsxx inquiry. jsp I

6 ILE RPG e-business application with subfiles



When the information is displayed, you click the Update Customer Record button.

o]

I http: fflocalhost: 9080 fwintlabsx feustDispUpdate. do j e

¢« 09 a1
=

Update Customer Record
Customer Number: 0010100

Customer Name: Meridien Electronics Limited
Representative Number. ’W

Contact: |Alfredo Bayonne

Phone Mumber, 1206-865-4027

Fan Number: |206-865-403?

Address: 110423 S E. 30th Place

City: Bellevue, WA

Country: USA.

Zip: 930086
Reset
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You change some of the fields and click the Submit button. You see the
confirmation page with the new values.

Ihttp:,l',l'lacahast:QDBDIwintlabxxicustDoUpdate.do j Cl«+= @ @“’9 = |
=
Update Complete
Customer Mumber: 0010100
Customer Name: Meridien Electronics Limited
Representative Number: 43443
Contact: Alfredo Bayonne
Phone Mumber: 206-865-4027
Fax Number: 206-865-4037
Address: 10423 S E. 30th Place
City: Bellevue, WA
Country: UsSA.
Zip: [U3006
Backto Customer Inguiry
=~
—=

You then click the Back to Customer Inquiry link and you return to the Customer
Inquiry page.
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Chapter 2. Module 2: Creating the customer list input page

In this module, you will learn how to create a new input page from a subfile and
link that new input page to the customer inquiry input page. You will also learn
how to add the iSeries business logic (service program) and additional parameter
to the existing Web application in order to process the request to get a customer
number. Remember: Before beginning this module, you should learn about the
Prerequisite knowledge for the tutorial.

In order to create the customer list input page, there are several steps you will
need to learn about and follow:

* Starting Development Studio Client

* Using Page Designer to create the customer list input page from a subfile
 Linking the inquiry page to the customer list page

* Creating another Web interaction to use the new input page

* Adding the iSeries service program (getCustNumber) to the Web interaction

* Adding a new parameter (cnumber) for the iSeries service program to pass the
customer number back to your new input page

In order to accomplish these learning objectives, there are several steps that are
involved, including:

Exercise 2.1: Starting the Development Studio Client workbench
Exercise 2.2: Opening the Web perspective

Exercise 2.3: Creating the customer list page

Exercise 2.4: Linking to the customer list page

Exercise 2.5: Creating another Web interaction

Exercise 2.6: Adding an iSeries ILE program to the interaction
Exercise 2.7: Adding a parameter

The exercises in this module must be completed in order. Start with Exercise 1.1
when you are ready to begin.

Length of time:
This module will take approximately 15 minutes to complete.
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Exercise 2.1: Starting the Development Studio Client workbench

Now go ahead and start Development Studio Client.

( T ID Workbench
@ WS_FTP ProEx )
7] Java 2 Runtime Environment

Start or Corfigt Q Lavasoft Ad-aware 6

7] Lotus Applications

EM&M& Word ﬂ Lotus SmartSuite
7 Microsoft Office Tools

. a Metscaps Communicator
St ) Morton Ankivirus Corporate Edition
F7) Object REX for Windows
) Palm Desktop
7] QuickTime

All Programs

* T w w w w Ow O w w ¥

To start Development Studio Client:

1. On the desktop task bar, click: Start > All Programs > IBM® WebSphere
Studio > Development Studio Client Advanced Edition for iSeries 5.1.

WebSphere Studio x|

WwiebSphere Studio stores wour work in a directory called a workspace. You can change the workspace each time
pou start WebSphere Studio. Specify the directomny to use for this session:

|E:'\.D0c:.rner!s and SettingsypurnichiMy DocumentshIBMywdschwintlabes Browse... |

™ Use this workspace as the default and do not show this dislog box again

o | Cancel |

A dialog for workspace selection will appear asking you for the workspace
location, unless you used the Development Studio Client before and selected
not to show this dialog again.

2. Name the directory of the workspace as shown above. Use the directory name

wintTlabxx. This is the same directory that you used for the tutorial called
Building an e-business RPG application.

Note: You must use the same workspace used for the previous tutorial as you
need to access an existing Web project and Web application that you
created in the previous tutorial called Building an e-business RPG
application.

3. Click OK.
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After a few moments of loading, the workbench opens, and the initial window
of Development Studio Client appears:

cﬁ: Remote System Explorer - Welcome - WebSphere Developme
Fil= Edit Mavigate Search Project Run Window Help

J ‘9|J3-F-§l|Jﬂ =R

=10/ x]

B || romot...tems w x X | [Outline x
o et 4 2 |
| > ¢ - & | Development St... g
(= a| An outline is
oo = TThis page tells wou what you should know before you— not available.
3 - Developmenk Studio Client Advanced Edition For iSerie ||
E J; U G and click on the related links,
LR wWindows... i
1
[+ Linee, .. —
b ] 3 Get started |
[#- e Ui, . |
Ta know what to do first, consult the Product Ov
=B Local.. the inFormation map in the online help to decide F l
LB a iSeties... start using the product. :
#-E Local :
1
{3 Develop iSeries applications
You can create and maintain RPG and COBOL app ||
Learn more about the Remate System Explorer a |
4 I ;I_I i
8 Remote System Details |=€>E Pl a e x
N R |
Remote Systems | Team |
Properties v X
|5 3% 5
Property I Value
4| | » | | Remote System Details ]Tasks jiSeries Table View |iSeries Commands Log

Exercise 2.2: Opening the Web perspective

In this exercise you will use the Web perspective since it gives you access to
unique views and tools targeted towards Web tasks.

You first need to open the Web perspective to create a new customer list page. The
perspective should already be open, but if not, check the workbench task bar on

the left for the Web perspective icon, otherwise follow the steps below.

To open the Web perspective:

Project Run | Window Help

|35 - & - ewWi‘lduw I|f_- S

d * SRemote System Explorer
Show View 4

S Hide Editors
1. Click Window > Open Perspective > Other from the workbench menu.
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The Select Perspective dialogs opens:

4 Select perspective SN
WJava ﬂ

S'C'Java Erowsing

f:JJava Type Hierarchy

=] Plug-in Development

d] Prafiling and Logaing

%Remote System Explorer {default)
Resource
 server

TjWebFa:ing

[X] %rL

Sk %5l Debug (=

2. Select Web from the list.
3. Click OK.

The workbench shows the Web perspective with the Web Projects open in the
Project Navigator.

You are now ready to create the customer list page (custList.jsp) which will pass
the customer number to the inquiry page (inquiry,jsp). You also need to modify the
inquiry page by adding a link (Find button) that will open the customer list page.

Exercise 2.3: Creating the customer list page

You will create the customer list page using several Page Designer iSeries Web
components.

To create a new customer list file:

?5 Praject Mavigator v X
. e
T wintlabxx
AR

Praoject Navigator |Galler&_ar | Struts Explorer

1. Locate the project wintlabxx that you created in the previous tutorial.
2. Expand the wintlabxx folder, if not already expanded.
3. Navigate to the WebContent folder in your project.
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4. Right-click the WebContent folder and click New > JSP File on the pop-up

menu.

v X
& oo A .=;f':'
E‘;; winklabsex -

- & web site Configuration
= 'qz] Web Deployment Descriptor
[#- 52 JavaSource

WG Go To » O Folder
&N HTML/XHTML File
B .

€)™ JavaScript File
i -5 [xelete... & 55 File
: oy MaVE. ., .
Project Mavigat Rename. .. E Image File

The New JSP File page opens:

&b New ISP File

Mew ISP File

Specify a name and location For the new J5P file,

I,

Folder: | Jwintlabee:WebContent Browse, .,

File Name: | l:l.lstList.jsp)
Markup Language: |HTML j
Options: ™ Create as 15P Fragment
I™ Use %ML Style Syntax
Model: |Nona

Generate a new blank JSP page.

I 3 {3

™ Configure advanced options

<Back [ x> || Fish | Cancel

5. In the File Name field, type custList.jsp.
6. Click Finish to create a new JSP file.
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The Page Designer opens in the workbench:

Protor w x || Tastistiso X | x
G D & E]~ | pooy - | Standard ~
& »
= 59 wintlabc.a Place content here.

o $= Bulleted List

§= Ordered List

7 Teble

~— Horizonkal Rule
‘! [ .4 Layout Bax
Project ... G4 P % Row (Table)

#2 Column (Table

Attributes x 3 (Table)
BODY ~ Deslqn]che,Prevlew

Background and || quick Edt [BODY] - Javascript X

Image: O~ R <

Color ?EI Insert an action/is] | on

¥ JavaServer Pages
EBackgrount Fe . Bl Parts
CTEE [ J—I < | » | = Page Templats

ﬁbtrbutes‘SH » QulckEdtJTdcsﬁolnrsﬁervers Pab&eJSrippets

To add the iSeries table component:
1. Select the Snippets tab in the bottom right of the workbench.

] Check Box

{—f Cambo Box

@ Hyperlink

¥ Image

% Image Button

7] Label

= Radio Button Group

01 Text Entry

15P -
Paletig ] Snippets

2. Expand iSeries Web Components.
3. Select Table and drag it to your JSP under the text "Place content here”.

Make sure the Design page is selected to place the table component on the new
custList.jsp page.
You have selected the iSeries Table Component.
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4. If you see this dialog, click Yes.

&b rwrLooo9 : x|

The Page Designer should look like this where the iSeries Table is on the
Designer page.

R <]
custLi....jsp * El~ | wowtaste + | Standard +

-

Place content here.

Design | Source |Preview

Now you select the attributes for the table.

To select attributes for the table:

1. The Attributes pane in the bottom left of the workbench should open
automatically. If not right-click on your table object and click Attributes on
the pop-up menu.

Place content here.

g’/ o,
s
Z

of” Cu
" B3 Copy
[ Paste

#8 Delete

h““““““

Rl

& 47 Insert Link...
Page Properties...
Style 3

[

8 attributes |

Next you fill in the general attributes for the iSeries Table.
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2. In the Attributes pane, select the General tab.

© Attributes = IWCLIWTABLE ~ X
Pararneters] Features | Columns | Styles |
Mame: ‘ CUSTLIST =

Initial state: I~ Hidden

Orientation: |(Default) =l
Tool tip: |

Saletion mole: |
Formatting:

Get lacale-sensitive values from: IhDst system values j

Nierirnal cvrabind - |_ ;I

attributes |Styles | Thumbnails

3. In the Name field, type CUSTLIST.
4. Select Single from the Selection mode list.
5. Click the Parameters tab to set the parameters for the iSeries Table.

e A':tributes_'_ IWCLIWTABLE ~ X

QeneraEeatures | Qolumns] Skyles |
@;et data from an iSeries service program =

€ \Writes a page at a time
" WWrites a page as requested

Service program parameters:

Mame | Data bype | Length | Decimal

add I Qr-rr.r.-..'r-l I l P I _,;I
1| | »

Attributes Styles | Thumbnails

Select the Get table data from an iSeries service program check box.
In the Library field, type wdscsubf.

In the Object field, type wdscsrv.

Click the Writes entire subfile radio button.

Next you set the features for the iSeries Table.

© ® N o
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10. Click the Features tab.

IWCLIWTABLE » X

General | Parameters Features |golumns | Styles ]

Table features:
' Show toolbar

¥ Enable table rows to be collapsed and expanded
¥ Enable sorting
[V Enable filtering

I show filter row

V' Show header
¥ show footer

¥ Enable paging

Initial page I
Rows per pag

IV Show gridiines

This will switch to the Features Attributes pane.
11. In the Rows per page field, type 10.
12. Click the Columns tab.

This will switch to the Column Attributes pane where you set the columns for
the iSeries Table.

IWCLIWTABLE » X

General | Earametersl Eeatured
Columns

Mame | Length | Heading text | Features [ Tvp

@ Fir:.'n-:'-.-'s—l Up | Dowr I

< | i

13. Click Add.
14. Fill in the following, and click Add after each row.

NAME LENGTH HEADING TEXT
custNumber 7 Customer Number
custName 40 Customer Name
custPhone 17 Customer Phone Number
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Your completed Attributes pane for your table columns should look like this:

e A':tributes_'_ IWCLIWTABLE ~ X

General | Parameters | Eeatures  Columns |§tyles |

Columns
Hame | Length | Heading text | Features
custhumber 7 Customer Mumber
custMame 40 Custorner Name

custPhone [ 17

Customer Phone M...

Add | Rernovel Up I Do I
e ||

Attributes |Styles | Thumbnails

Now insert a form on the page.

To insert a form on the page:

1. Place your cursor below the table in the Page Designer (if not already),

right-click and then click Insert > Form and Input Fields > Form on the
pop-up menu.

custList.jsp - custlist.jsp * E] ~ | BODY

Flace content here.

a8 Form |
|Custumer Number |Custumer Name Cusl

Submit Button, ..
Reset Button...
# Link....
| Image Button. ..
of” Cuf 4 fnchor... General Button. ..
Copy Image File »  Extended Button...
i Background Image File P
[ Paste Background Music » @ RadioButton...
# Delete - | Check Box...
W Free Layvout Tiable
Save ™ Textcell Text Area..,
AR ) o
| 5P 3 Lisk » File Selection Field...
[ .
— s Insert Link... _
=& , & Table... List Box...
E Page Properties... .
_F Style i Horizontal Rule =" Drop-Down Menu...
g F— O b Ty | Group Box...
o [B QuickEdit > Seript [
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2. Place your cursor inside the dotted rectangle, which represents the form that
you just created.

B X
custList.jsp - custList.jsp * E] - | FORM ~ | Standard ~

-

Place content here.

Customer Customer Customer Phone
Number Name Number

S

Design |Source |Preview

Next you want to access the Snippets view again to select an iSeries Button
Component.

To add the iSeries Button Component:

1. Navigate back to the Snippets view. Select the Snippets tab at the bottom right
of the workbench:

Wi, Snippets £ v x

) Messages =

'y Pages

) Date and Time

) Objects and Images
iSeries Web Components
Button

Box

[ Combao Box

E{ﬁ Hyperlink.

[#] Image

=4 Image Button

7] Label

& Radio Button Group

[£] selection Box

B Table

E Text Area

01 Text Entry

@1 350 E
Palet@n—ippﬂts!

2. Expand iSeries Web Components if not already.

3. Select Button then drag it to the form and drop it.
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You have placed the iSeries Button inside the form on the page.

BRE x|
custList.js. . tList.jsp * E] - | rwoLweuTTON v | Standard ~

-

Place content here.

Customer Customer Customer Phone
Number Name Number

4 of]

Design |Source |Preview

Next you complete the iSeries Button attributes.

To add iSeries Button attributes:

1. The Attributes pane for the button should automatically show up; if not,
right-click the button and click Attributes on the pop-up menu..

5 IWCLWBUTTON = X
Events | Styles |

Iame: isplay

Label:

et Customer Numbet)

Button type: |Submit

Initial state: [ Disabled
I Hidden

Orientation: [(Default) i

Tool tip: |

Access key: I
Tab index: |

Attributes Styles | Thumbnails

2. In the Name field, type display.

3. In the Label field, type Get Customer Number.
You have finished creating and modifying the iSeries Web Components.
Let’s add a heading to this page.

To add a heading to this page:
1. Select the text Place content here.
2. Replace it with the text Customer List.
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3. In the Attributes pane on the bottom left of the workbench, select Heading 2.

5 Project Navigator

* X

@r*custList.jsp x l

Ay

"|:"- + :U::"‘\l‘

custLi....jsp * EFl ~ | H2 = | Standard =

-4 wintlabxx

- Javasource
=8 WebContent
®-= META-INF

4

- B web site Configuration <
- ﬁ_f] Web Deployment Descriptc

N . A

§éust0mer List )

B

Project Mavi... |Galer~; | Struts Explorer

Hz » X

Alignment: I(.nuto) v l

[ — 1

R

Customer
Customer | Customer
Phone
Number Name
Numbher

Get Customer Number I -------------------- P

R 4
4 >

Design |Source Preview

&) Quick Edit [HZ] - Javascript  §2 » B < w X

¥ oar= Insert an action/code snip}=
> 4] I v

Attributes |5tvles |Thumbnails

Quick Edit |Tasks | Colors | Servers

You are finished creating the JSP.
Your finished page should look like this:

Bl custlist jsp X |

cuskList.jsp - custList.jsp

El- | He~ | standard -

RS

‘Customer List

“

‘Customer Number ICustnmer Name |Customer Phone Numhber

Design | Source |Preview

4. If you haven’t done so already, save the JSP file (Ctrl + S).

Exercise 2.4: Linking to the customer list page

Now, let’s modify the inquiry page so that you can link (Find button) to the

customer list page.

1. In the Project Navigator, right-click inquiry.jsp.

Chapter 2. Module 2: Creating the customer list input page
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2. Click Open on the pop-up menu to edit the inquiry page named inquiry;jsp.

Project Mav'ﬁ N
© D> XS

] - [w) denimd03bu.gif <
- error.jsp {
Bl inquiry. jsp

18} lagen.jsp Hew ’
% messages. Go To L
@ rylogo. gif Open

(&) rvlogo. mil Cpen With U
@r Recordiot
-8l result.jsp Copy

- [%) uD13cut.g Paste
-4y wdt400br, Delete. ..

B wintlabxx,
G Mave...

Project Navigator |Gallery  Rename...

The Page Designer opens in the upper right pane of the workbench and shows
the inquiryjsp as the Web Interaction wizard created it and with the changes
you made in Page Designer.

?}wsﬂist.jsp W x l

inquiry.jsp - Customer Inguiry El -~ | FORM = | Standard ~

Customer Inquiry ¢¢ :

-'-]‘ |

| BV Laboratory

R LTRSS

RN TR

Ssinguiry . button. submit | “oinquiry button.reset |

-

Design | Source |Preview

3. Make sure that you are on the Design page in Page Designer. Select the Design
tab.
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4. Now put the cursor after the text field as shown:

?}wsﬂist.jsp W x l
inquiry.jsp - Customer Inguiry El -~ | FORM = | Standard ~
Customer Inquiry ¢¢
s L LA i o i e
Z
1B
Wilaboe | 2
Z
g
i s
| 0A Laboratory :
2 Z
TR TEE AR AR e &
‘é%inqui.ry.label_Enter_custamer_nmnber | E
,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,, :
4
Ssinguiry . button. submit | “oinquiry button.reset | g
s, I, o T
E §eslgn !Snuce |Preview
5. Right-click the page and click Insert Link on the pop-up menu.
@custList.jsp W X ]
inquiry. jsp - Customer Inquiry of~ Cut | Standard ~
Copry. ..‘_l
Customer Inqi.
% Delete
Save
Insert S
J5P 4 '
Table 4 ;
Insert Input Fields » E
Insert Link. . :
Page Properties... :
Style 4 '
Attributes '
Quick Edit
Layout Mode 4
E%mqu_lahel_Enter_custnmer_nmnberg - JBuntating :
sttt s s et e st et st et s tanran st tassesses o s et !
! Sinquiry.button.submit | %inquiry.button.reset | 5
R p—— ! :
Design |Source |Preview
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The Insert Link dialog opens:

&P Insert Link ' X
Type
= File C HTTP  FP
" E-mail " Others

E ——

URL: custList, jsp Browse - I
Register as Alias. .. I

Link te@

Target: | =l

6. In the URL field, type custList.jsp.
7. In the Link text field, type Find.
8. Click OK.

The Customer Inquiry page after adding a link to customer list page
(custList.jsp) should look like this:

- custList jsp |_ﬁ1 g x |

inquiry.jsp - Customer Inguiry * El -~ | AT | Standard ~

Customer Inquiry ¢¢

I AT Laboratory

B e e e e E e R R R NN N A e N AN RN RN E N NN AN AN ARSI it sty
e LA,
by

oinquiry.label Enter customer number | FindZ

L

Seinguiry . button. submit | einquiry button.reset |

Design | Source |Preview

9. If you haven't done so already, save the JSP file (Ctrl + S).

Now that you've added the Find link, let’s modify the style sheet so that the
link does not blend with the background.

To modify the style sheet:
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1. Locate the denim001.css file under wintlabxx > WebContent > WEB-INF.

Project Navigak v X
@ XS
#-5# JavaSource -

L—__g ‘WebConkenk
[+ (= META-INF
[+#-{z= theme
[+ (== WEE-INF
- changePassword. jsp
@' custLisk, jsp —

Project Navigator JGaIIsrv | Struts Explarer

2. Double-click denim001.css and you should see the following window:

?}wsﬂist.jsp | '_i-ﬂf’inq.lirv.)‘sp @ x l

Preview with; | <sample html file> vl /* Lpplies to overall page %4

: - BODT{

Open With | Browse %]I % “8 % T background-color : White;
- font-family : arial, helx

Selected Style }

<<< This area shows sample /% Headers and titles */

elernent of cursor position style HIA ;

S background-color : #637Bi

border-style : solid;
border : thin =solid #z44¢

Standard HTML Elements color : #ESEAFD;
font : bold;

Text in Body Text in Body padding-lefr : 10px:

Text in Body Text in Body margin-left @ 10px:

¥

Hz{
color : #244587;
border-kottom : mediuwn S
padding-1left : 10px:

Heading 1 margin-leftc : 10px;

h -
<| | 3

Heading 1
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3. In the right pane of this window, scroll down until you find the /*hyperlinks*/
section.

4l

/% Hyperlinks */

A{
text-degadagtion : underline;
color @

3
A:VISITED{

text-decoratipn : underline;

}

A:HOVER{
color @ H#BE9119;
text-decoration @ underline;
3

A ACTIVE{
color : HES7BAG
text-decoration @ underline;

¥

/* Lists */
OL{

color : #244987; d
4| | »

4. Type red beside color on the A section.
Type green beside color on the A:VISITED section.
6. Save the file (Ctrl+S).

o

Exercise 2.5: Creating another Web interaction

Next you create another Web interaction to use the new input page and output
pages that you just created.

To create another Web interaction:

1. Locate your project from the previous tutorial in the Project Navigator.

Project Navig i —

-

155 wintlabxxEAR

Praoject Navigator |Gallerv | Struts Explarer
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2. Right-click on your project and click New > Other on the pop-up menu.

Project Navig v X

B 3;
5o Into

Go To
Cpen in Mew Window

Copy
Paste
Delete. ..
Move, ..
Rename...

3 wirtizh: . . ¢ oiect...

» & Source Folder
() Folder

Import...
Export...

Project Mavigat

The Select page opens:

select

iSeries Web Interaction Wizard

- Eclipse Modeling Framework ;I f
EXB e -
i Example EMF Model Creation Wizards %Static Web Project
B Ieries %:‘Dynamic ‘Web Project
' jZEE g Image File
il HTMLIXHTML File
b- Plug-in Development @ 15P Fil
- Femote File Transfer _.é; Elee e
; lter
-~ Server s
- Simple “& Life-cycle Listener
- Symptom Database @' WML File
LlL_isualization ‘::Servbt
S\ CssFile
Cestruts f} Javascript File
- \WebFacing f& Database Web Pages
- Web Services % Java Bean Web Pages
ML
[+- Examples =
<ok [ met> | Fen | cance

3. In the left pane of the Select page, select Web.

4. In the right pane of the Select page, select Web Interaction.

5. Click Next.
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The Web Interaction wizard opens:

&P Web Interaction

Specify a Name and Location for your Web Interaction

Define the name and location for the communication between Web pages and the chosen business process. The kacation must be the Web Content
drectory inside a project.

Destination folder | fwintlabioxWebConkent

web Interaction nuw

lava package |

i fg,

(@ =X o )

[ Irwalidate session after the interaction oocurs

< Back Hext > Eich | cancel

In the Web Interaction name field, type getCustNumber.

Select the Use error page check box and select error.jsp on the Error page
dialog. Click OK.

Click Next.
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10.

11.
12.
13.

As you probably remember from the previous tutorial, this next page is where

you specify the input and output pages.

&P Web Interaction x|
Specily the Input and Dutput Pages for your Web Interaction

‘fou can use previously designed input and output pages For this Web mberaction or you can have the wizard generate them, °®®

Page preview:
I
" Generats input 15P
s P n
il pzes

<h:ust1ist,jso) add... |

" Generate output J5P

« uk pages:

finguiry jsp )
<Back Hext > dosh | cancel
Leave the Use input pages radio button selected and click Add.
Select custList.jsp on the Input page dialog. Click OK.
This is the subfile that contains the list of customers.
Leave the Use output pages radio button selected and click Add.
Select inquiry.jsp on the Output JSP dialog. Click OK.
Click Next.
You have now defined your input and output pages.
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Exercise 2.6: Adding an iSeries ILE program to the interaction

Next you will select the RPG service program you will use to handle your Web
interaction.

&b Web Interaction T x|
Specify the Input and Dutput Parameters for your iSeries Host Program
Specify program alias. 00®
@sﬁmiﬁeﬂssprtgaﬂmprmad.re  Use a Javabean " Mo program cal
Program call defintions Add Parameter... | Add Structure. ..
= o3, custinstruc ]
B custinguiryPGM = Add Program
Program alias: ] |
Program object: [ Browse. ..
Library: I
Program type: ]*PGM j
Entry point: ]
CCSID of entry poink: |
Return type: ]‘.'-:‘I-:l ;I
Thread safe: ]Falsg ‘:J
Source location: J :I ViEW, . |
¥ issociate this program with the interaction
Import PCML... I Synchronize All
O | Cancel |
< Back Hext > | Eirvist Cancel

To add a program to the Web interaction:

1. Leave the Use an iSeries ILE program radio button selected.

2. Click Add Program.

3. Click Browse to browse for the service program you will use.
If you don’t see your connection then you will need to create a connection.
Follow the steps under the section Creating a connection.

If you do see your connection then skip the following section and proceed to
the section Selecting the service program.

Creating a connection
To create a connection:

1. In the list in the left pane, expand the New Connection list item by clicking on
the plus sign beside its icon.

The Name personal profile page opens.
2. Accept the default profile. Click Next.
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4.

5.

The Remote iSeries System Connection page opens:

Remote iSeries System Connection

Define connection information !

Parent profile: | VURICH =]
Connection namgff | 54002 \

Host name: s4l:ltla_|‘/ j
Description: |

IV Vetify host name

ceeck | mext» [ Finih | cancel |

Leave the default value for the Parent Profile.

In the Host Name field, type the name of the iSeries server (Same server name

as you specified for the runtime).
Click Finish to create a connection.

Selecting the service program

Now you select the RPG service program.

1.
2. If you don’t see the WDSCSUBEF library, click Work with libraries and type

Expand your connection.

WDSCSUBF in the dialog, then click OK.

Chapter 2. Module 2: Creating the customer list input page

31



3. Expand the WDSCSUBF library and select the WDSCSRV service program.

&b Browse For Object x|

Expand a connection, a filter, a library, and select a program object.

| wDsCsRY

E‘ Mew Connection. ..

Lol Conmection created successfully, Expand this again to ¢
By s400a

= :%,"‘* Work with libraries. ..
w|¥7] Filter created successfully, Expand this again to cre
*LIBL
WDSCSUBF
=, WOSCSUBF. *lib

gl

=

®
8

i

.:|;

4t

«1 o

[ R 1
4. Click OK.

Most of the fields have now been filled in for you. However you must fill in
the values for the program alias and entry point fields:

4P Web Interaction

Specify the Input and Dutput Parameters for your iSeries Host Program
Usa this page to define the input and output parameters for your iSeries host program, Q

% Use an iSeries program or procedure " Use a Java bean " No program cal
Program cal definitions pddProgram... | Add parameter... | Add structure... |

M o3, custinstruc -

# 5 custinguiryPaM = Add F —
Program alias: getCustMurmber
Program object: WOSCSRY Browse... |
Library: | wosCs LR
Program type: [+SRVPGM |
Eniry point: readc __)
CCSID of entry point:
Retumn type: Ivuld :I
Thread safe: [false =
¥ | sssodiste this program with the interaction

Import PML.. | Synchranze al |

< Back Hext = Firrsti Cancel
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5. In the Program alias field, type getCustNumber.

6. In the Entry point field, type readc (case sensitive).

7. Click OK.

Exercise 2.7: Adding a parameter

Let’s add this structure as a parameter to the service program that you just added

in the previous exercise.

To add a parameter:

1. Under Program call definitions, select the getCustNumber program.

Click Add Parameter.

In the Length field, type 7.
Select Output from the Usage list.

o gk~ wN

Your wizard should now look like this:

Leave character in the Data type list selected
In the Parameter name field, type cnumber.

&P Web Interaction

Specily the Input and Dutput Parameters for your iSeries Host Program

Lise this page to define the input and output parameters for your iSeries host program.

% Use an iSeries program or procedure " Use a Java bean

Mo program call

Program call defintions add Program. . -l Add Structure... |

i ClsHEehn ;I
1| getCusthumber Add Parameter
e =]

# =] o

Parameter name:
Data bype:
Structure name:
Length:

Precision:

I Advanced...
Specify database reference fisld Specify...
Import PCML... Synchronize Al Show database field definition SHOW. -+ |

onumber
character x
T -

7. Click OK.

You have finished adding program parameters. Now you need to setup the

JSP’s.
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8. Click Next.

&P Web Interaction x|

Map and Link the Input Parameters to the Input Fields
Link the parameters in your program to the fields on your Web page, Data entered into the input field on your Web page vl be passed to the
corresponding input parameters n your program.

Input page Fields:
=@ foustList jsp
=) FORM:rull Fields | Parameters |
B custsT

- display

Link | Uik | Input parameters:

Froperty | Value

<tk [Ciois )  nsh | concel |

9. You have no input parameters, so you don’t need to modify this page.
10. Click Next again.
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11. Under Output parameters, select cnumber.

&P Web Interaction 34 x|
Map and Link the Dutput Parameters to the Output Fields
Link the: parameters in your program to the fields on your Web page. The value of the output parameter in your program is passed to the %
correspanding output fields on your Web page. ®
Linlink
i cnumber =@ finquiry.jsp
- = FORM:myForm
sugtoner number:
7 enumber
o v
[ Reset
Property | value |
Data Type: character(7) _Property | value |
Mame in Session:  cnumber Mame in Session:  cnumber
Save to Session:  false Restore from S... false
Flow Controller:  false
Message Indic... False
< Back | Mext > “ Finish | Cancel |

12. Under Output page fields, expand /inquiry.jsp > FORM:myForm and select

cnumber.

13. Click Link in the middle of the page.
14. Click Finish to link the output field to the output parameter.

Recap

Congratulations! You have completed Module 2: Creating the customer list page.
You should now understand how to:

Start Development Studio Client

Use Page Designer to create the customer list input page from a subfile
Link the inquiry page to the customer list page

Create another Web interaction to use the new customer list input page
Add the iSeries service program (getCustNumber) to the Web interaction

Add a new parameter (cnumber) for the iSeries service program to pass the
customer number back to your new customer list input page

Now that you have created a new input page from a subfile, linked that new input
page to the customer inquiry input page and added the iSeries business logic
(service program) and additional parameter to the existing Web application in
order to process the request to get a customer number, you can continue to Module
3: Adding the iSeries program to your Web application.
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Chapter 3. Module 3: Adding the iSeries program to your Web
application

In this module, you will learn how to use the Remote System Explorer perspective
to edit and compile an iSeries program.

In order to add the iSeries program to your Web application, there are several
steps you will need to learn about and follow:

¢ Opening the Remote System Explorer perspective
* Editing an iSeries source member

* Compiling source changes

Note: To access iSeries data and resources you will need to have a job description
setup and associated with your user profile on your iSeries system.

In order to accomplish these learning objectives, there are several steps that are
involved, including:

Exercise 3.1: Opening the Remote System Explorer perspective
Exercise 3.1: Editing an iSeries source member
Exercise 3.3: Compiling source changes

The exercises in this module must be completed in order. Start with Exercise 2.1
when you are ready to begin.

Length of time:
This module will take approximately 5 minutes to complete.

Exercise 3.1: Opening the Remote System Explorer perspective

To open the Remote System Explorer perspective:
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1. In the workbench check whether you have the Remote System Explorer

perspective already open. Look for the icon in the left taskbar of the
workbench.

&P Web - WebSphere Development Studio Client Ad:
File Edit Mavigate Search Project Run  ClearCase

J'f? ~ & B & J -E 1'. |J L‘& |J ;-*—I - J_g
|

] Y wintlabiec:

o wintlabxxEAR

Project Navigator |Gallery | Struts Explorer

2. If you see it, click the Remote System Explorer icon.

Otherwise, click Window > Open Perspective> Remote System Explorer on
the workbench menu.

The Remote System Explorer perspective opens.

Exercise 3.2: Editing an iSeries source member
You will see a list of servers in the Remote Systems view.

To edit a member:

1. Double-click Work with libraries.

Il Remote Sy v X
2P e e |®F
E;& MNew Connection

#-B Local

-8y s400a

=gy s400a

= .'.‘JQ iSeries Objects

. }:&* Work with libraries...
:",=:€» Work with objects. ..
-2 Work with members. ..
i Library list

LW iﬁ# User libraries

+-g& iSeries Commands

[+ gy iSeries Jobs
& Ty IFS Files
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The Library Filter page opens.

X
Library Filter .
Create a new iSeries library filker =i
=
Library: |wdscsuhf| =] J Browse. ..
= Back I Mext > I Firishi Cancel
In the Library field, type WDSCSUBF.
Click Next.
X
Library Filter *_
Mame the new filter E: S
ad

Filters are saved for easy re-use, Specify a unique name For this filter, This name will
appeat in the Remote Systems view, and will be expandable.

Filter name: | WDSCSUBF

<Back | Next> || Fish | Cancel |

In the Filter name field, type WDSCSUBF.
Click Finish to create the library filter WDSCSUBE.
Next you edit the source file.
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6. Expand WDSCSUBE.*lib.prod.

) §in iSeries Objects ]
-2 Wark with Tbraries. .
-5 Work with objects...
£} :%:b Work with members. ..
[ W Library list
&= i"—? User libraries
=gy WDSCSUBF
W, WOSCSUBF.*lib.prod
[+ l@ WDSCSRY . *srvpgm.rpale
[+ 5] WDSCSRY, *madule
& CUSTOMER. *file.pf-dta
] CUSTOMLL . *file.IF
] CUSTOMLS, *file.If
- (3 EVFEVENT *file.pf-dta
=1y QDDSSRC. *file.pF-src
=-E) QRPGLESRC. *file.pf-src
[y SUBFILEPRZ.rpgle
(%) STRCODE*y  ©0To

]
T
]

=

2] aﬁ iSeries Commands

; Open With
- @ iSeries Jobs

Browse With

s LPEX Editor

[ 4
B %2 IFS Files {485 CODE Editor

7. Expand QRPGLESRC *file.pf-src.
8. Select WDSCSRV.rpgle.
9. Right-click WDSCSRV.rpgle.

10. Click Open with > Remote Systems LPEX Editor on the pop-up menu.

Tip: You can also double-click on a member to open the Remote Systems

LPEX editor.

The editor window opens. You are ready to write your program.

11. Add the following source changes:

14900 * Update the customer record

15000 DdolUpdate PR ExtProc('dolUpdate')
15100 D info LikeDS (CustInfo)
15200 D forward 204

15300, -

15301 * Return customer muunier

15302 Dreadc PR ExtProci('readc')
15303 I info Like (Custno)

15305 *

15306 i

15307 *

15400 {Copy WDSCSUBF/QRPGLESRC, SUBFILEPRZ

15500 e e e
15600 * BldSfl
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12. Now, add these source changes at the bottom of the source file.

* readc

T Eeturn customer nunbher

preadc B export
d readc pi
d info like [CUSTNO)
*
C Eval re=readceSF (Custlist:
C % Addr (CustcRec) @
C ¥Size(CustReo):
C 1)
C If re > 0
c Eval info = 3f1ID
[ Endif
C

*

FPreade E

*

&% End of Jource

13. Save the file (Ctrl + S).

Exercise 3.3: Compiling source changes

You need to compile your source file in order for the changes to take effect.

There are two steps to compile: create a module and then create the service
program.

To create the RPG module:
1. In the Remote Systems view, select WDSCSRV.rpgle.

M5 Remote Sy Open With PRV X
o ol A o g ' »
EOc > | X P b DIZ CLONDtFactor Lt e
e actor -
=G ISeries Objects f1 Rename c
£ b wWork with libraries. .. o c
3 :% Wark with objects. .. | Copy .
-5 Work with members,.. 5+ Move -
-, o "
Lib lissk:
E2 i" forary list # Delete c
- User lbraries c
= i WDSCSUEF Verify N
E- M, WDSCSUBF. *ib.p  Verify (Prompt)
ol WDSCSRV.*s Complle » Pdolpdate

) WDSCSRY. *m
#- & CUSTOMER.*
QL] CUSTOMLL*F
6] cusTOML3*F  Add To iSeries Project... }
o3 5] EVFEVENT *il  Make Avallable Offine 3 work With Compils Commands. ..
& 5y QDDSSRC*i |
= El QRRGLESRC. S '

-y SUBFILEPl  properties

User Actions

(&) STRC
- a*_ iSeties Commands
- 5 iSeries Jobs

o e o

7 Tasks (3 items)
| ] * | pescription
I & The import java.math is never used

2. Right-click and click Compile (Prompt) > CRTRPGMOD in the pop-up menu.
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The Create RPG Module (CRTRPGMOD) dialog opens:

4P Create RPG Module (CRTRPGMOD) _ x|
Module: = MName -l
Library: WDSCSUBF =] Name
Source file: QRPGLESRC fad Mame, QRPGLESRC
Library: WDSCSUBF il Name
Source member: WDSCSRY v | Mame
Generation severity level: 10 0-20
Text 'description': *SRCMBRTXT _V_] Character value...
Advanced Parameters
Compiler options: - Add
*EVENTF
Debugging views: *SOURCE ;]
[~ Advanced () [ all parameters(y) [~ Keywords(Z)
CRTRPGMOD MODULE(WDSCSUBF'WDSCSRY) SRCFILE(WDSCSUBFIQRPGLESRC) SRCMER({WDSCSRY) OPTION{*EVENTF) ;I
DEGYIEW(*SOURCE)
‘ ' estore defaults Cancel |
I - |
3. Click OK.

ies Commands Log

SRCMER{WDSCSRY) OPTION{*EYENTF) DEGVIEW(*SOURCE) -
Module WDSCSRY placed in library WDSCSUBF. 00 highest severity, Created on 02/18/04 at
13:24:53.

Cause . ....: Module WDSCSRY was successfully created in library WDSCSUBF. The

highest message severity that resulked was 00, The module creation date and time are

02/18/04 and 13:24:53,

hd
Command INarma1 ﬂ I LI Brompt,., I Ry
Remiote System Details |Tasl-<s |iSeties Table Vievﬂ_' Erﬁes Commands LE?Series Error List ]Cunsnle

4. Check the iSeries Command Log and see if the module was created.

You have now completed the first step of the compilation process.
Now you complete the second step in compiling the source file.
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To complete the second step:

=g WDSCSUBF Yerify 019100
& M, WDSCSUBF.*IB.0r0  verify (Prompt) 019200
1w WDSCSRY *srvl compile » 013300

- §) WDSCSRY, *mod Jsp—"
T Cornpile (Prompt) Con CRTENDRPG. ..
- CUSTOMER.*Fik ™\ jser Actions . _:‘5
(] CUSTOMLI *file v [ CRTRPGMOD...

*

PdoUpdat.

*

f‘j CUSTOMLS, *file &dd To iSeries Project. ..
w-[F EVFEVENT *file.  Make Available Ofiine

11-Ely QDDSSRC, ile,
E @] QRPGLESRC, *fi Compare With

-0y SUBFILEPRZ oo

WDSCSRY roge

-(&) STRCODE.*usrspc.usrdft ‘ Eé Eeries Commands Log

1. Right-click WDSCSRV.rpgle.

2. Click Compile (Prompt) > Work with Compile Commands in the pop-up

menu.

The Work with Compile Commands dialog opens:

cﬁ: Work With Compile Commands

Parent profile: fvurICH

Member type: lRPGLE ﬂ Add... | Rermove |

Compile Commands:
e 2zl News compile command:
NEW COMmmana
CRTEMNDRPG —
CRTRPGMOD Label: < iCRTSR'v‘PGM )
Command:
TSRYPGI 2]
' ;I_I
Insert variable. .. Edit... I Browse. .. I
ot

3. In the Label field, type CRTSRVPGM.
4. In the Command field, type CRTSRVPGM.
5. Click Prompt.
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10.
11.
12.
13.

The Create Service Program (CRTSRVPGM) dialog opens:

4P Create Service Program (CRTSRYPGM) x|
Service program: &n Mame =
Library: &l B Name
Module: *SRYPGM Jad Name, generic™
Library: *LIBL =] Add | Name
Remove
p——
Export: *alL } =
Export source file: QSRYSRC hd Name, SRYSRC
Library: *LIBL hd Marme
Export source member: *SRYPGM hd MName
Text 'description’: *BLANK EI Character value
ced Parameters
Bind service program: qutssfl -
Library: asys| d
Binding directory: *FNONE =
Library; *16L I
®:Ivanced L [ Al Parameters [~ Keywords
CRTSRYPGM SRYPGM(ELj&N) EXPORT(*ALL) BNDSRYPGM(QSYS/QDTSSFL) |

‘ K ’ | Restore defaults Cancel

In the Service Program field, type &n.
In the first (top) Library field, type &1.

In the Export list, select *ALL.
If you cannot see the Bind service program, select the Advanced check box.

In the Bind service program field, type qdtssfl.

Click Add.
Click OK.
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14.
15.
16.
17.

The Work with Compile Commands displays:

&b work with Compile Commands . x|
Parent profile: fvurICH ~|
Member type: lRPGLE ﬂ Add... | Rermove |
Compile Commands:

e 2zl News compile command:

NEW COMmmana

CRTEMNDRPG

CRTRPGMOD Label: I CRTSRVPGM

Command:
ICRTSRYPGM SRYPGM{ZLI&N) EXPORT*ALL) BNDSRYPGMI ;I

| | ;ILI

Insert wariable. .. | Edit... I Browse. .. I

Revert |

Close I
| 2|

Click Create to add the new compile command.

Click Close.

Right-click WDSCSRV.rpgle.

Click Compile (Prompt) > CRTSRVPGM on the pop-up menu, then click OK.

& i WDSCSUBF Verify ST .
=il WOSCSUBF il Werify (Prompt) 019200 Pdol
[+ 32 WDSCSRY.  Compile » 019300 *
& % WDSCSRV. Compile (Prompt) E‘ﬂ{ CRTBNDRFG. ..
@[5 CusTOMEF i 5
3 Cstomt User Actions v By CRIRPGHOD...

<7 cusTomz  Add TaiSeries Froject...
T evrevent.  Make Available Offline

Eh qoDssRE. ' 5 work with Compile Commands..
= »
T % GRPGLESH Compare With .
oy SUBFIL  Properties I—
i [D il Hy.rpgie

~(&) STRCODE.*usrspc,usrdft rﬂ; iSeties Commands Log

This completes the compilation step. The service program is created. Now you
are ready to test the modifications.

Recap

Congratulations! You have completed Module 3: Adding an iSeries program to
your Web application. You should now understand how to:

¢ Open the Remote System Explorer perspective

Edit an iSeries source member

* Compile source changes

Now that you have used the Remote System Explorer perspective to edit and
compile an iSeries program, you can continue to Module 4: Creating the update
record output page.
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Chapter 4. Module 4: Creating the update record output page

In this module, you will learn how to create a new output page for your existing
Web application. This page will update customer information and will be
generated from the Web interaction wizard.

In order to create the customer update output page, there are several steps you
will need to learn about and follow:

* Generating a new update record output page using the Web interaction wizard
* Creating an error page to handle errors during the update record process
* Linking the customer details page to the update record page

In order to accomplish these learning objectives, there are several steps that are
involved, including:

Exercise 4.1: Generating the output page from the Web Interaction wizard
Exercise 4.2: Linking to the update record page
Exercise 4.3: Creating the update error page

The exercises in this module must be completed in order. Start with Exercise 4.1
when you are ready to begin.

Length of time:
This module will take approximately 15 minutes to complete.

Exercise 4.1: Generating the output page from the Web Interaction
wizard

You will create the update record page using the Web interaction wizard.
To create the update record page:

1. Open the Web perspective.
2. Locate your Web project in the Project Navigator.

g o (£ :ﬂ{ =.§F
o wintlabxod

155 wintlabxxEAR

Project Navi... |Gallery | Struts Expla. ..
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3. Right-click your project and click New > Other on the pop-up menu.

Project v x

Open in Mew Window

Copy

Paste

The Select page opens:

b D EOE &5

= 1 M :

- wintlab = Project...
Go Into —e ]
Go To » 2 Source Folder

£ Folder

select

iSeries Web Interaction Wizard

[+ Data

b= Eclipse Modeling Framewark

el o 8 static web Project
Examﬂe EMF Model Creation Wizards %Dynamic Web Project
[+ iSeries "

- & Image File

' HTML{XHTML File

- Java N 357 Fil

- Plug-in Development b e

- Remote File Transfer -;% E':::L“b Listener

L Seryver =

... Simple @- WML Fil

- Symptom Database g Serviet

M) Visualization §» Cs5File

f} JavaScript File
- acing [3‘ Database Web Pages
- Web Services % Java Bean Web Pages
ML
[+- Examples =
ok [ wea> | At | cance

4. In the left pane of the Select page select Web.

5. In the right pane of the Select page, select Web Interaction.

6. Click Next.
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The Web Interaction wizard opens:

&P Web Interaction

Specily a Name and Location for your Web Interaction

Define the name and location for the communication between Web pages and the chosen business process. The lacation must be the Web Content
drectory inside a project.

Destination folder | fwintlabioxWebConkent
ﬁ

‘Web Inkeraction mm(' custDisplipdate ]

Java package |

®B°"‘°'N°° ‘Ifﬂ'ﬂ'ﬁﬁ ’

[ Irvalbdate session after the interaction occurs

i fg,

<Back Hext > Fish | Cancel

7. In the Web Interaction name, type custDispUpdate.

8. Select the Use error page check box and select error.jsp on the Error page
dialog. Click OK.

9. Click Next.
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10.
11.

12.

13.

This next page is where you specify the input and output pages.

&P Web Interaction 5 X|
Specily the Input and Dutput Pages for your Web Interaction
‘fou can use previously designed input and output pages For this Web mteraction or you can have the wizard gensrate them, °0®
Page preview:
 Generate input 15P
(= Use input pages:
=D-“;-
( fresult.jsp ) Add...
Rermtrve |
hLr Generats output J5P
™ Use output pages:
add.. |
Rermmve |
Preyien I
< Back Next > Fosh | cancel

Leave the Use input pages radio button selected and click Add.
Select result.jsp on the Input dialog and click OK.

This is the page our original Web Interaction generated, we are now linking it
with another Web Interaction.

Click the Generate output JSP radio button to tell the Web Interaction wizard
to make an output page.

Click Next.

On the next page, you will need to add another program instance and define
the input and output parameters for this Web Interaction.

You will notice that the structure and the program from your previous Web
Interaction are visible, and available for your use.

To add a program:
1. Click Add Program.
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2. Fill in the program details as shown:

‘&W-_'I.l Interaction ﬁl
Specify the Input and Dutput Parameters for your iSeries Host Program
Lisa this page to define the input and output parameters for your iSeries host program, 0@@
% Use an iSeries program or procedure  Uss a Java bean . o program cal
Program cal definitions addparameter... | add structure... |
H 0% custinstruc ;I —
& B custinguiry PG | | AddProgram
=5 Program alias: custDusprdﬂe\
Program object: [woscsey ' Browse... |
Library: | wosCsUBF
Program type: [*sRrwpGM |
Entry poink: displipdate|
CCSID of entry point:
Return type: Jvoid |
Thread safe: false |
[ | tissociate this program with the interaction
Import PCML... I Synchronize All I
(2 P comcel
< Back Hext » Firrsti Cancel

3. Click OK when finished.

You will see that the program has been added under the Program call
definitions.

To add parameters:
1. Click Add Parameter.
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2. Fill in the parameter details as shown:

&P Web Interaction

Specily the Input and Dutput Parameters for your iSeries Host Program
Uise this page to define the input and output parameters for your iSeries host program., 000

% Use an iSeries program or procedure 1~ Use a Java bean € Wo program call

addprogram... | addparameter... | add gtructure... |

Add Parameter

S

Parameter name: cnumber
Data bype:
Structure name:

I Advanced...
Specify database reference field Specify... Syndironize |
Import PCML... Synchronize Al | Show database field defirition Show..,

oF

<ok | Mext> |  Ensh | cance

3. Click OK when finished.
Now we need to add the structure you defined in Exercise 2.6.
4. Click Add Parameter.
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5. Fill in the details as shown:

&P Web Interaction

Specily the Input and Dutput Parameters for your iSeries Host Program
Use this page to define the input and output parameters for your iSeries host program.

% Use an iSeries program or procedure

" Use a Javabean

€ Wa program call

Program call definkions Mnmram...' add parameter... | add Structure...
. - Add Parameter
- = =i ar
% B custinguir Parameter name:
i [ getCusthumber Data type:
Structure name:
Length:
Predision:
Count:
Usage:
Initial vahe:
™ Advanced...
Specify database reference fisld Specify... Synchranize |
Import PCML... Synchronize A1 | Show database Field definition SEOM s
o
<pack | Mew> | Ensh | cancel

6. Click OK.
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Your wizard page should now look like this:

&P Web Interaction

Specily the Input and Dutput Parameters for your iSeries Host Program
Specify details sbout the parameter to use, Enter parameters manually in the table below or dick Specify to enter them using database definition, 00@

* Use an iSeries program or procedure 1~ Use a Java bean

fmport PCML... | Synchronizead |

€ No program call

addprogram... | addparameter... | add structure... |

Add Parameter

Parameter name: ||—
Data bype: character -
Suctrename: | <]
Length: [ =
Count: [
Usage [optsotpt =]

Initial vahse: I

™ Advanced...
Specify database reference fisld
Show database field definition

Synchranize |

<gack | mew> [ Ensh | cancel

You can see the new parameters you have defined for this interaction.

7. Click Next.
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The input parameter page opens:

C&Wl:b Interaction : zl
Map and Link the Input Parameters to the Input Fields

Link the parameters in your program to the fields on your Web page, Data entered into the input field on your Web page vl be passed to the

corresponding input parameters n your program.

Input page Fields:

=@ fresub.jsp
= FORM: e Eorm

Property | value I
_Property | value | Data Type:  character(7)
MName in Ses... struc_CUSTHNO Narme in Ses... crwmber
Save to Ses... false Restore fro...  False
Message 1D Get Browser,., false

<gack | wext> |[ Ensh | cancel

Now you will link the input page parameter.
8. Under Input page fields, select the struc_ CUSTNO parameter.
9. Under Input parameters, select the cnumber parameter.
10. Click the Link button in the middle of the page.

You have just linked a parameter from the input page to the input parameter
of our program.

11. Click Next.
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Now its time to design the output page:

&P Web Interaction

Design the Result Form

Specify the page properties and the output parameters that the generated Web page wil display to the user as output,

Output g

f] @l custrec.cusTD
2P et 10
B alicustrec REPNG

Ballcustrec.conTAC 7 |
el custrec.cPHONE =

B alicustrec.crax Nong |

Ballcustrec.CADDR
Eaicustrec.cciry
[ @i custrec.CCOUNT
Ealicustrec.czIP

B allcustrec.czipio

Title Color
Fiald Color

&

Update Customer Record

CUSTNO:
CUSTHNA
REPNO:

CONTAC:

CPHOME:
CFAX
CADDE:
CCITY:

CCOUNT:

CZIP:
CZIPLO:

First you will change the output page title.

To design the output page:

1. In the Properties table, select the Page tab.

2. Change the value of the Page Title property to Update Customer Record.
Now you need to change the field labels to make sense and to make them

editable.

ILE RPG e-business application with subfiles




3. Click the Fields tab.

&P Web Interaction \ : X
Design the Result Form

Specify the page properties and the output parameters that the generated Web page wil display to the user as output, 090
Qutput parameters: ;I
[Flallcustrec.cusTne MHove

Bl el cuoma o | Update Customer Record

Hallcustrec REPNO Mgve down |
Bl custrec. CONTAC a @
& @i custrec CPHONE ;I

@l custres crax Nong CUSTHA:
[P @i custrec.CADDR REPNO-
MEaicustrec.camy
[l custiiec.cOUNT CONTAC:
Maicustrec.czip CPHOMNE:
Halicustrec.czrLo CEAY
CADDER:
CCITY:
CCOUNT:
CZIP:
CZIPLO:
MName n Session: CLUSTHO
Sarve to Session: False
D | !

« Back. | Tdent > || Finish I Cancel

4. Under Output parameters, select custRec. CUSTNO.

5. In the Properties table, change the value of the Label property to Customer
Number.

6. Select Text from the Input Style list.

7. Repeat for the following by changing their Label fields to their respective
names in the table below, and by changing all their Input Style fields to Text.

8. Make sure that their Size and Max. Length fields are the same.

CUSTNA Customer Name
REPNO Representative Number
CONTAC Contact

CPHONE Phone Number

CFAX Fax Number

CADDR Address

CCITY City

CCOUNT Country

CczIp Zip
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Your page should now look like this:

&P Web Interaction

Design the Result Form

Specify the page properties and the output parameters that the generated Web page wil display to the user as output,

‘Qutput parameters: ;I
M@l custrec.custio Move up
2] aflcustRec CLSTHA tpew | Update Customer Record
Halicustrec REPNOD Mgve down |
[Fl /i custhec CONTAC A
[Faicustrec, CPHONE Al | Customer Humber. |
E;::cmuam Nong Customer Mame: |
] @ i custRec.CADDR .
BEalicustrec.coamy Fepresentative Mumber: |
. Contact |
lcustrec,CZIPLO Phone Mumber: I—
Fax Number I—
Address: |
L |
Pr
Label; Country: I
Drata Type: Tip'
Input Style: P I
Input Choices:
Sz 10
Mama in Session: CZIP
Sarve o Session: False
A

<« Back | Tdext > || Finish I

9. You have chosen not to use the CZIPLO field. Clear this check box.

10. Click Finish.

11. Navigate to your new page custDispUpdateResults.jsp and double-click the

file.

The Page Designer opens.

12. Select the text field for the Customer Number.

|

¥ [;]

~ | IWCL:WIEXTENTRY - | Standard -

75 Project Navigator v X
¢ 9 B4

. =-# webContent <
4| | B

-

Project MNavi... IGdIary | Struts Explo. ..

(3) Attributes x

te Customer

IWCLWTEXTENTRY ~

General | pata | Events | 4[]

] custRec_CUSTR =

Input type: Text

Size: [

Initial state: [ Dis3

Marne:

Origntation:

ecord ¢¢

Design | Source |Preview

Initial value: !

| I;lzI

Console [WebSphere v5.0 Tes...ironment {WebSphere v5.0)] x

B k-8 4

Altributes J Styles | Thumbnails

Quick Edit | Tasks | Colors | Servers [ConsnlaJ
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13.
box.

You don’t want to allow

14. Save and close the JSP.

In the Attributes pane, set the field to Read-only. Select the Read-only check

the user to change the customer number.

Exercise 4.2: Linking to the update record page

Now let’s modify the customer details page so that you can link to the update

record page.

To link to the update record page:

1. In the Project Navigator,

drill down to your result.jsp page and double-click.

[0 -~

result,jsp - Untitled *

EJ -~ | | Standard -

P

r‘%result lahal Z1p

e

Customer Details ¢

O T AN S E AT ERANT E RS O T SO E OSSR AR R TR RS

"%result label_Customer Number f .

7Back to Customer Inqu.iry']

ki

TRV

Design | Source |Preview

2. Select the Submit button and press the Delete button.
3. Select the Reset button and press the Delete button.

4. Type Back to Customer

Inquiry.
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5. Highlight the text Back to Customer
on the pop-up menu.

Inquiry, right-click and click Insert Link

[0 -~

result,jsp - Untitled *

Bl

| Standard -

|aj’C|.t
() Copy

Ereantreanteeanseennseens: [T Paste
’%result label Customer

3% Delete

-

Fails s¢

Save

Insert 3

£ Insert Link...
Page Properties. ..
Style ]

(@) attributes
B Quick Edit
Layout Mode »

=+ Run ke Ling

Design | Saurce |Preview

The Insert Link dialog opens.
6. In the URL field, type inquiry.jsp.

&P Insert Link x|

~Type
* File  HTTP  FTP
" E-mail " Others

URL: |inquiry.jsp Browse |

Register as Alias. .. |
Lirk bk I
Target: | =l
OK I Cancel
7. Click OK.

60 ILE RPG e-business application with subfiles



8. Put your cursor right before the Back to Customer Inquiry link and press

10.

Enter on your keyboard.

[0 -~

result,jsp - Untitled *

E] -~

p - | Standard -

"%result label Customer Number

""z%result label Customer Name

’%result lahel er
.ﬂ

(bbb A Lo LAt AL AT e L D A LS L LRl R Ll Sl

Customer Details ¢

Wil
Badk to Customer [nquiry
\T T

SERIEIED

gl = =

-

-

Design | Source |Preview

In the right pane, click the Snippets tab and expand iSeries Web

Components if not already expanded.

Click and drag the Button component to the location shown.

LLC}:\U.LI. laucl INCRLCHCTULAUYE l‘{u.LllUEL:

-struc_CCIT"

sstruc CCOL

"%result lah p

Components

[ fEutton
.

[f Combo Box

[E# Hyperlink

:@] Image

& Image Button

7] Label

(» Fadio Button Group
£} Selection Box

I Table
; eo E Text Area
\Back to Custormer Inquiry 2| = Text Entry
4] | 3
Design |Sc|uroe | Preview
Consale [\WebSphere ¥5.0 Te...ronment (WebSphere v5.0)] X &) 5P -1

Quick Edit | Tasks | Colars | Servers |Consa!e |

Paletbﬂ éippels 2

The Attributes pane in the bottom left of the workbench should automatically

appear.
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11. If not, right-click the button and click Attributes on the pop-up menu.

af” Cut
Copy
[ Paste

# Delete

Save

Insert »

5P ’

Insert Input Fields »
47 Insert Link...

Page Properties. ..

Style ’

B attributes

[E Quick Edit
Layout Mode »

= Run to Line

12. Fill in the Button’s details as shown below:

© Attributes IWCLWELTTON = X

General | Events | styles |

Name: | Update =
Label: | Update Customer Record|

Button type: "_:-Lbrlit j

Tnitial state: [ Disabled
I™ Hidden

Orientation: ](Default) j
Tool tip: i

Access key: ’ ~|

attributes J Styles | Thurmbrails
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Your Customer Details page should now look like this:
B ]
result jsp - Untitled * E] - | mwcewsutton + | Standard +

5 session. se..

Customer Detalils s+

Woresultlabel_CustomerNumber 1
"-:-L%'r'éé{;ié label_Customer_Name ~ : shoe. CUSTHA
'%'r}ééiﬂé label,_Representative, Number :struc_REPNO | :
Siresitlabel, Contact “struc_ CONTAC :
“}é}}és}{ﬁéiél}éi"Iiiic'.i]}:"'ﬁiﬁiﬁijé}”'”"”"fét}'ﬁi:”iiiii{'bﬁé 5
f‘%result ] ahel Fax S stﬂ:u:: o,
“L%}E;{ﬁéiéﬂéi'ﬂéh}ééé'"""'"""""":ét'r'ﬁi:"'dl&jfiﬁiii"_
‘%resdtlahelCltystrucCCITY .....
eresultlabel Country struc_ CCOUNT :
;/iaresdtlahelfbp .......................... strucCZIP ......
3 Update Customer Record  EsR, :
Back to Customer Inquiry :

Design | Source |Preview

13. Save the file (Crtl+S).

Exercise 4.3: Creating the update error page

Now let’s create the error page that will be displayed if there is an error during the
update process.

To create the update error page:

1. In the Project Navigator, expand your project if not already and drill down to
the WebContent folder.

2. Right-click the WebContent folder inside your project.
3. Click New > JSP File on the pop-up menu.
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The New JSP File dialog opens:

&p New J5P File : x|
Mew ISP File
Specify a name and location For the new J5P file, @
Folder: Jwintlabxx/WebContent Browse, .. |
ﬁ
File Name: < UpdateError
Markup Language: |HTML El
Options: I” Create as 15P Fragment
[" Use %ML Style Syntax
Madel: ’None

Generate a new blank JSP page.

I 3 { K

¥ Configure advanced options

<ok | Next> || Fish |  Cancel

4. In the File Name field, type UpdateError.jsp.
5. Click Finish.

The Page Designer opens. Your window will look like this:

- o

UpdateError.jsp - UpdateError. jsp El~ | BODY ~ | Standard ~

-

IPlace content here.

v
4 »

Design |Source Preview

6. Click the words "Place content here” and change it to An error occurred
during update.

7. Highlight your new text.
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10.
11.

12.

This opens the Attributes pane.
workbench.

It appears in the bottom right of the

- B web site Configuration
- %) web Deployment Descriptor
- JavaSource
£-(Z# ‘WebContent
. B META-INF
(= theme
[-(Z WEB-INF
@ changePassword. jsp

Project Navigator | Gallery | Struts Expl

5 Project Navigator v x | B tupdateErmor.jsp x|
L 2 &M =§' UpdateError,..Error.jsp * =] - H3 = | Standard -
= Q wintlatuo: -

A

[ |
1 Error Occured During The Update. ¥

-
4 r

Design |Source | Preview

© Attributes /HS - X
Paragraph I
Paragraph: [hormal =
Head‘!ng 1
Heading 5
Heading 6
Alignment: |(A|.ta) 'I |

B Console [WebSphere ¥5.0 Test Environment {WebSphere v5.0)] X
B k-84

[2/18/04 14:49:28:613 EST] 4ea2f9lad UebGrnuZI
[2/18/04 14:49:28:707 EST] 4ea29lad WebGrou
[2/18/04 14:49:28:754 EST] 4ea28lad Propert
[2/18/04 14:49:28:754 EST] 4ea2S9lad Propert
[2/18/04 14:49:29:628 EST] 4ea29lad Propert

TZI/.I.IS('D‘I 14:49:29:660 EST] 4ea22lad Applical
4 »

Attributes |Styles | Thumbnaits

Quick Edit |Tasks lCuhts | Servers [Cnnsole ]

Select Heading 3 from the Attributes pane.

Place your cursor below the heading you just created, and press the Enter key

two times.

Type the text Back to Customer Inquiry.
Highlight the text and right-click.

Now you will define the link.

UpdateErrar.. Ervor.jsp * E]~ |

| Standard -

BRy

BRy

Back to Customer |

of Cut
Copy
[ Pasts
Design | Source |Preview #§ Delete

An Error Occured During The Update.

B Console [WebSpher:  Save

[ebSphere «5.0)] x

[2/18/04 14:49:; £ Insert Link..

[2/18/04 14:49:: Page Properties...
[2/18/04 14:49::
[2/18/04 14:49::

mk-284 Insert >

[2/18/04 14:49:: J5P 3

Style »

lad WebGrou<
lad WebGrou
iad Propert
1ad Propert
1ad Propert

[2/18/04 14:49:: (3) Attributes
4
Quick Edit

Quick Edit | Tasks | Colors

lad Apvplical
»

Click Insert Link on the pop-up menu.

The Insert Link dialog opens.
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13. In the URL field, type inquiry.jsp.

&P Insert Link x|
~Type

* File  HTTP  FTP

" E-mail " Others

URL: |inquiry.j5|:|] Browse |
Register as Alias... |

Lirk bk I

Target: | 4|

o | cancel [

14. Click OK.
Your UpdateError.jsp should now look like this:

UpdateError...Error.jsp * E]~ | | b ©

An Error Occured During The Update.

BRy

BRg

3ack to Customer Inoquiry

Design |Source |Preview

15. Save the file.

You are now ready to use the Web Interaction Wizard to add the flow control
parameter.

Recap

Congratulations! You have completed Module 4: Creating the customer update
output page. You should now understand how to:

¢ Create another Web interaction.
* Link the new page in the Web interaction.

* Create an error page.

Now that you have created the update record output page, you can continue to
Module 5: Creating the update complete output page.
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Chapter 5. Module 5: Creating the update complete output
page

In this module, you will learn how to create the customer update complete output
page.

In order to create the customer update complete output page, there are several
steps you will need to learn about and follow:

* Generating a new output page using the Web Interaction wizard

* Adding the flow control error page

 Linking the update record page to inquiry page

In order to accomplish these learning objectives, there are several steps that are
involved, including:

Exercise 5.1: Generating another output page using the Web Interaction wizard
Exercise 5.2: Adding the flow control error page
Exercise 5.3: Linking the update complete page to the inquiry page

The exercises in this module must be completed in order. Start with Exercise 5.1
when you are ready to begin.

Length of time:
This module will take approximately 15 minutes to complete.

Exercise 5.1: Generating another output page using the Web
Interaction wizard

Now you will create the Web Interaction that will actually update the record on
the iSeries. It will read the input variables from the custDispUpdateResults.jsp.

To generate another output page:
1. Right-click your project and click New > Other on the pop-up menu.

-] . k)

Project Haw v X

= 0o £ )‘.{ =§=

g o i d ™ Project...

win Go Into -
Go To » & Source Folder
Open in Mew Window X Folder
{2 Caopy

Paste
Delete. ..
Move...

Project Navi  Rename...

The Select page opens.
2. In the left pane, select Web.
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3. In the right pane, select Web Interaction.

Xl
select 9,9
iSeries Web Interaction Wizard ﬁ

[ Data Y ¢

- Eclipse Modeling Framework T

--EJB N static Web Project

- Example EMF Model Creation Wizards %Dynamic Web Praject
[+ iSeries @ Image File
E] igi BNHTML{XHTML File

- Plug-in Development .@\ ]SP File

- Remote File Transfer :% :'::L“b Lctener

- SEtver Chubd

- Simple @ WL File

- Symptom Database " Servlet

- LML Visualization 5} (55 File

- Web ) f} JawaScript File

- WebFacing I} Database Web Pages

-~ Web Services @ Java Bean Web Pages
[+- Examples =

<ok [ mwet> | Foen | cancel

4. Click Next.
5. In the Web Interaction name field, type custDoUpdate.

&P Web Interaction

Specify a Name and Location for your Web Interaction

Define the name and location for the communication between Web pages and the chosen business process. The kacation must be the Web Content
drectory inside a project.

Destination folder | fwintlabioxWebConkent

‘Web Interaction nﬂ! | custDolipdate )

lava package |

i g,

@UWM (lmﬁ }

[ Invabidate session after the interaction occurs

< Back Hext > Fish | Cancel
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6. Select the Use error page check box and select error.jsp on the Error page
dialog. Click OK.

7. Click Next.
Now you define the input and output pages.

b Web Interaction . xJ

Specily the Input and Dutput Pages for your Web Interaction
‘fou can use previously designed input and output pages For this Web mberaction or you can have the wizard generate them,

Page preview:

" Generats input 15P
JrustDispUipdateResults. jsp € .\ldd...;
Rermtre |

™ Use output pages:

<Back Hext > Fsh | cancel

8. Leave the Use input pages radio button selected and click Add.
9. Select custDispUpdateResults.jsp on the Input page dialog. Click OK.

This is the page our original Web Interaction generated, you are now linking it
with another Web Interaction.

10. Click the Generate output JSP radio button to tell the Web Interaction wizard
to make an output page.

11. Click Next.

Now you will add a program.

To add a program:
1. Click Add Program.
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2. Fill in the program details as shown.

4P Web Interaction zl
Specify the Input and Dutput Parameters for your iSeries Host Program
Usa this page to define the input and output parameters for your iSeries host program, 0@@
% Use an iSeries program or procedure  Uss a Java bean . o program cal
Program call definitions addparameter... | add gtructure... |
@ o8, custinstruc | e ——
& B custDispUpdate _~| | AddProgram e
B custinguiryPGH
5[] getCusthiumber Program alias: custDoUpdee\
Program object: | woscsey ] Browse... |
Library: =
Program type: [*srwpGM |
Eniry point: dolpdate /
CCSID of entry point: T m——
Return type: Jvoid |
Thread safe: false =
[ | aissodiate this program with the interaction

Impart PCHL... Synchronize Al |

< Back Hext Firrsti Cancel

3. Click OK when finished.
You will see that the program has been added under Program call definitions.
Now you need to add the structure you defined in Exercise 2.6.

To add a parameter:
1. Click Add Parameter.

ILE RPG e-business application with subfiles



2. Fill in the details as shown:

C& Web Interaction Il
Specily the Input and Dutput Parameters for your iSeries Host Program
Use this page to define the input and output parameters for your iSeries host program. 000
% Use an iSeries program or procedure 1~ Use a Java bean € Wa program call
Program call defintions add Program... | addparameter... | add gructure...
& o, custingtruc |
] custbolpdate A Add Parameter

% ™ custDispUpdate

=B custinguiryPEh Parameter name:

i [ getCusthumber Daka bype:
Structure name:
Length:
Precision:
Count:
Usage:
Initial vahse
™ Advanced...
Specify database reference field Specify... Syndiranize |

import PCML.. | Synchronize sl | Show database field defirition SEomes
=
<gack | Met> | Ensh | Cancel
3. Click OK.

Now you will add the flow control parameter.
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4. Fill in the parameter details as shown:

&P Web Interaction

Specily the Input and Dutput Parameters for your iSeries Host Program
Use this page to define the input and output parameters for your iSeries host program.

% Use an iSeries program or procedure

= 5] custDispUpdate
# [ custinguiryPGM
# =] getCusthumber

fmport PCML.. | Synchrorizead |

=l

" Use a Javabean € Ho program call

add Progran... | Add Structure. .. |

Add Parameter
Parameter name:
Data bype:
Structure name:
Length:

™ Advanced...
Specify database reference fisld Specify...

Synchranize |

Show database field definition SHOW. .

5. Click OK when finished.

ILE RPG e-business application with subfiles




Your wizard page should now look like this:

&P Web Interaction x|

Specily the Input and Dutput Parameters for your iSeries Host Program
Specify details sbout the parameter to use, Enter parameters manually in the table below or dick Specify to enter them using database definition, 00@

* Use an iSeries program or procedure " Use a Java bean € No program call
Program call definkions Mnmram...' WE&Mr..,' Add:bruml
> J=
=B “""mbdm ;I Add Parameter
-4 custRec (oustinstruc)
*q i forward Parameter name: ||

E - Data bype: character -

# =] custinguiryPGH Iﬁ

51 B getCusthumber Structure name: =
Lengeh: [ |
Predision: I vI
Count: I
Usage: |Ir1u.t B output vl
Initial vahse: I
™ Advanced...
Specify database reference fisld Specify... Synchranize |

Import PCML... Synchronize Al | Show database field defirition Stom. .,
oK | Cancel |

<gack | mew> [ Ensh | cancel

You can see the new parameters you have defined for this interaction.
6. Click Next.
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The input parameter page opens:

&P Web Interaction

Map and Link the Input Parameters to the Input Fields

Link the parameters in your program to the fields on your Web page, Data entered into the input field on your Web page vl be passed to the

corresponding input parameters n your program.

e o
=@ {oustDisplpdateresults.jsp

B
beResults.jsp-c...
([ CUSTREC LUoTNA JeustDep e
0@ custRec_REPNO icﬁﬁﬂxtiﬁs-jswm
d s.jspec...
q«.]_:j :ﬁ:—gm JeustDispUpdateReskts jsp-c...
- JeustDispUpdateResults.jsp-c...
@7 custhec_CFAX JeustDispUipdateResuits.jsp-c...
i custRec_CADDR JeustDisplUpdateresults.jepec. ..
0 custhec_CCITY JeustDisplUpdateResults. spec...
t],-ﬁ custRec_CCOUNT JeustDispUpdateR esults. jspec. .
17 custhec_cCzIP
=3 Submit
- [ Reset
Property | vaue |
Mame in Ses... custRec CZIP
Save to Ses... false
Message ID:

custRec. REPNG
custRec CONTAC
custRec. CPHONE
custRec. CFAX
custRec. CADDR
CustRec. CCITY
custRec. CCOUNT
custRec. CZIP

1% custRec CONTAC
11 custRec. CPHONE
1B custhec CRaX
% custRec CADDR
A% custRiec COITY
15 custRec, CCOLNT
B custRec.czIP
AP custRec CZIPLO

Property | Value

DataType:  characten(10)
Name in Ses... CZIP
Restore fro...  false
Get Browser.., false

<gack | mew> [ Ensh | cancel

Now you will link the input page parameters.

7. Select an input page parameter under Input page fields.

8. Select the respective program input parameter under Input parameters.
9. Click the Link button in the middle of the page
You have just linked a parameter from the input page to the input parameter

of your program.

10. Repeat for all remaining input page parameters.

Now you design the output page.

To design the output page:
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1. Click Next.

4B Web Interaction zl
Design the Result Form
Speacify the page properties and the output parameters that the generated Web page will display to the user as output. 0@@
Cutput parameters: B
custRec. CUSTNO
S " oo | Update Complete
[ acustrec REPNG Mgve down
E.] custRec. CONTAC Al CUSTHO:
[ @i custrec.CRHONE ;I ‘
[ @'l custrec.crax M CUSTHNA:
[# @l custrec.CADDR. EEPHO:
Hacustrec.cary CONTAC
[/l custrec.CCOUNT '
[ @ custrec.czIP CPHOME:
[ aicustrec.cziPLO CEAX
[Faiforward CADDR:
CCITY:
CCOUNT:

5 CZIP:

opert;

Page Title CZIPLO:

Background Color forward:

Title Color

Field Color

<Back pet > [ Ensh | concel

2. In the Properties table, click the Page tab.
3. Change the value of the Page Title property to Update Complete.
Now change the field labels to be readable.
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4. Click the Fields tab.

4P Web Interaction

Design the Result Form

Specify the page properties and the output parameters that the generated Web page will display to the user as output.

custRec.CUSTNO
IEE Update Complete
[Facustrec.REPNO Mgve down |
g:}i:j::::comnc Al | Customer Mumber,
[ alicustrec.crax M CUs :
[#) @l custhec.cADDR, EEPHO:
Hacustrec.comy CONTAC
[F @ custRiec.CCOUNT ’
[ e custrec.czip CPHONE:
[ @' custrec.czipLo CEAX
[ aiforward CADDR:
CCITY:
CCOUNT:
CZIP:
W czmro.
Data Type: forward,
Irput Style: Label
Input Choices: e
Sizen 7
Name in Session: CUSTHO
Save to Session: fake
=@ -
< Back Hext > | | Einish I

5. Select custRec. CUSTNO from the left.
6. Change the value of the Label property to Customer Number.

7. Using the table below, change the values of the remaining properties:

CUSTNA Customer Name
REPNO Representative Number
CONTAC Contact

CPHONE Phone Number

CFAX Fax Number

CADDR Address

CCITY City

CCOUNT Country

czip Zip

Now, let’s disable the values you don’t want to be displayed.
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As a final step, you choose not to use the CZIPLO field and not to display the

forward field.

4B Web Interaction

Design the Result Form

Specify the page properties and the output parameters that the generated Wab page wil display to the user as output.

Cutput parameters: ;I
[H e custrec.ousThD tove up |
Bl icustrec.cusTia Updﬁte Com plete
@ |custrec REPNO Mgve down
[H el custrec.CONTAC
Bla/lcutrec, Al | Customer Humber.
Bl custrec.crax None | Customer Mame:
[/l custrec.CADDR Repre & Mumber:
Haoustrec.cary Contact
A el custrec.cCoUNT
Phone MNumber:
{custRec.CZIPLO Fax Number:
{Farward Address:
City
Country.
Property | abue | Zip:
Label: Zip
Data Type: character{10)
Irput Styde: Label
Input Choices:
Sizen 10
Hame in Session: ZIP
Save to Session: False
Page |Filds | =
<Back pevt s [ Ensh | cancel

8. Clear their respective check boxes.

9. Click Finish.

Exercise 5.2: Adding the flow control error page

Now that the update complete page (custDoUpdateResults.jsp) is created, you can
add the flow control error page.

1. Drill down through your project and find the Web interaction file named

custDoUpdate.wit.

Project Mavi

o o (£ :D: __z_';'la
wintlabx

=5

: q» web Site Configuration

- @ wWeb Deployment Descriptor
3% JavaSource

-8 webContent

=l Libraries

'%3 custDispUpdate. wit

% cus

EInquiry . wit

i S mebruickamerhlmber i *|
Project Navigator |Gallery | Struts Explorer

|»

2. Double-click the Web interaction file.

The Web Interaction wizard opens.

3. Click Next.

Next you add the flow controlled error page.
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4. Click Add as shown:

&b web Interaction

Specify the Input and Dutput Pages for your Web Interaction
You can use previously designad nput and output pages for this Web interaction or you can have the wizard generate them.

Page preview:

I Generats input 357
 Use inout pages:
foustDeplipdatef esits. fsp

<gack | met> [ Emh | concel |

5. Select UpdateError.jsp on the Output page dialog. Click OK.

6. Click Next until you reach the Map and Link the Output Parameters to the
Output Fields page:

Fi|
Map and Link the Dutput Parameters to the Dutput Fields
Link the parameters in your program to the fields on your 'Web page. The value of the output parsmeter n your program s passed to the cormesponding output fislds on your Wb page. %Q
Outpuk parameters: Lk I T I Output page fields:
€ custftec CUSTNGD = e jep
o caRec QUSTRA Paramaters | Frekas | @) Jupdateror. i
£ cunnec REPNO custRee CUSTHOD | custDelipdateRendts, ..
3 ustRec CUSTHA  custDolpdateRes s, .,
i custRiec, COMTAC utRsc REPNG  custDolpdateResdts, .
€ custitec, CPHOKE custRec CONTAC | custDolpdateResdls. .
€ custRec CFAX ustRec CPHOME  custDolpdateRiests...
€5 cuRec CADOR custRec CFAX custDolpdateRendts, .
f custitec, CCITY custlec. CADOR  custDoUpdateRlests. .
z: tFroc, CCOUNT ustec. CCITY custDoUpdateresults, .
] ! ustRec CCOUNT  custDoUpdateresults, .
A custitec 2P ustRiec CZIP custDoUpdateRes s, .
@l ceRec CZPLO
allforverd
_Propesty | value
DataType:  charactes(20) Broperty | vshie |
Hoorme in Sesssi... Forward
Save to Sessi... | Fase
Flow Controler: T =l
Message Indi...  False
<gack | wews |[CEmh ]| conel |

7. Under Output parameters, select the forward parameter.
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8. Select the value true for the Flow Controller list:

Property | value |
Data Type: character(20)
Name in Sessi... Forward
Save to Sessi... False
Flows Controller: true

Message Indi..,

9. In the Flow Control Specification dialog, click New and type 0K in the Value

field.
&b Flow Control Specification x|
Yalue | Output J5p | mew
[s'4 custDoUpdateResults, ..

Delete |
Move up |
Move down |
| oK I Cancel I

10. Click New again.
11. Type BAD in the Value field and select UpdateError.jsp as the Output.jsp
12. Click OK.
You return to the Web Interaction wizard.
13. Click Finish.

Exercise 5.3: Linking the update complete page to the inquiry page

Next you edit the update complete page (custDoUpdateResults.jsp) to add the link
to the inquiry page.

To link the update complete page to the inquiry page:
1. Navigate to your custDoUpdateResults.jsp file and double-click.
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The Page Designer opens.

custDoUpdateResults. jsp - Untitled El - | BODY -~ Standard ~

Upd ate Complete 3

Design |50urce | Preview

2. Select and delete the Submit and Reset buttons.
3. Type Back to Customer Inquiry where the Submit and Reset buttons were

shown.
custDoUpdateResults. jsp - Untitled * El -~ | P~ | Standard ~
[ |
Update Complete ¢
"oZ%EEsiBSH}E&;‘téﬁé;&it?f;ﬁéf ‘Customer_Number  icustRec_CU é‘fifé'
© 5

Design | Source |Preview

4. Highlight the text and right-click.
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5. Click Insert link on the pop-up menu.

REsmATESAATESSATE S

E“’/ocustDispUpdatE ‘f Cut

.................... Style

[ ETTTITTTT TIPS Abtributes
WocustDispUpdate —
¢ PUPCEAL = o ik Edit

13

1
Back to Customer [0quiry

E;%custDispUpdatf Layout Mode

Design | Source | Preview

The Insert Link dialog opens.

6. In the URL field, type inquiry.jsp.

&P Insert Link x|
~Type

* File " HTTP " FIP

" E-mail " Others
URL: |inquiry.jsp Browse |

Register as Alias. .. |
Lirk bk I
Target: | =l
OK I Cancel
7. Click OK.

8. Save and close the JSP file.

Recap

Congratulations! You have completed Module 5: Creating the update complete

output page. You should now understand how to:

* Generate a new output page using the Web Interaction wizard

e Add the flow control error page

¢ Link the update complete page to the inquiry page.

Now that you have created the update complete output page, you can continue to

Module 6: Running the updated Web application.
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Chapter 6. Module 6: Running the Web application

In this module, you will learn how to run the updated Web application.

In order to run the updated Web application, there are several steps you will need
to learn about and follow:

* Restarting the server
* Testing the Web application

Note: To access iSeries data and resources you will need to have a job description
setup and associated with your user profile on your iSeries system.

In order to accomplish these learning objectives, there are several steps that are
involved, including:

Exercise 6.1: Restarting the server
Exercise 6.2: Testing the Web application

The exercises in this module must be completed in order. Start with Exercise 5.1
when you are ready to begin.

Length of time:
This module will take approximately 15 minutes to complete.

Exercise 6.1: Restarting the server

If the server is still running from the last time you ran the Web application, it
needs to be restarted. The server will pick up changes in the Web application only
when it is restarted. If the server is not started, then you must start the server
before you can restart the project.

1. In the Web perspective locate the Servers view at the bottom of the workbench.
Click the Servers tab.

2. Right-click the server and select Start on the pop-up menu.
The server will show Started status when the start operation completes.
3. Right-click the server and select Restart Project on the pop-up menu.

Switch Contiguration [ 4 l

Restart Project | A wintlabsecERR

iy Add and remove projects... &P wintlab:

Run universal test client
Restart universal test client 5
PR servers o S XSG
Rur administrative console

[} Create tables

WebSphere v5,0

Server

Server is synchronized

4. Then click your project on the pop-up menu.
5. Continue with the Testing section.
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Exercise 6.2: Testing the Web application

To test the customer list page:
1. Right-click Inquiry.jsp and click Run on Server on the pop-up menu.
2. Click OK to accept the defaults on the dialog that opens.

mr x

Ihttp:,l',l'locahost:Sl]SD,l'Mntlebxx,l'i'iquiy.isp L’ (> | & o @ €§3 = | i
4l
Enter customer number:
-
Dane I

3. Click the Find link.
The Customer list page opens.
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4. Select the first entry on the list.

B <

Ihttp:,l',l'locahost:QUSDIwintlabxx,l'wcl‘du?wclhidden=action_20F55625&j (] | = @ 6§9 i | i

Customer List -
¥ 2 g2 B | [ Select Action— | [Go]
Select Custorner Number Customer Mame ' Customer Phone b
® 0010100 Meridien Electronics Limited ‘206-865-402?
© 0010200 Rovyal Hardware Supplies 905-619-2045
© 0010300 Webster Appliances 619-549-5212
© 0010400 ProLine Building Supplies 905-403-4055
© 0010700 Universal Communications Ltd. 415-545-5055
© 0010800 Baker Electronics 818-715-2045
© 0010900 Village Telephone 707-367-4530
© 0011100 BelAir Communications incorp.  914-765-8021
© 0011300 Burnham Trading Inc 613-225-0753
© 0011400 Calderone Imports 407-392-7077
Page 10f8/ b | [1 |Go| | Total 71 Filtered: 71 Displayed: 10 Sele

| Get Customer Number |

-
4 | e

Dane

|

5. Click the Get Customer Number button.

Ihttp:,l',l'localhost:9]8U,l‘wintlabxx,l‘getCustomerNumber.do?displav=Get- ﬂ (>} | @ &fﬁ a | i

al

=WV Laboratory

Enter custormer number: 00010 |

| Submit | Reset

Done
6. Click the Submit button.
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The Customer details page opens showing the details of the selected customer.

Ihttp:,l',l'lclcahclst:QDBDIwintlabxxicustInquiry.do j Cl«+= @ @“’9 = |
=
Customer Details
Customer Number: 0010100
Customer Name: Meridien Electronics Limited
Representative Number, 43443
Contact: Alfredo Bayonne
Phone Number: 206-865-4027
Fax Number: 206-865-4037
Address: 10423 S E. 30th Flace
City: Bellevue, VWA
Country: US A
Zip: 98007
Update Customer Record |
Back to Custorner Inguiry
=~
http:f flacalhost: 9080/ wintlabsxx inquiry. jsp

To test the update record and update complete pages:
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1. When the information is displayed, click the Update Customer Record button.

o]

I http: fflocalhost: 9080 fwintlabsx feustDispUpdate. do j e

¢« 0S| B

Customer Name:

Contact:

Phone Number:
Fax NMumber:
Address:

City:

Country:

Zip:

Reset

Update Customer Record

Customer Number:

Representative Number: 43443

=

0010100

Meridien Electronics Limited

\Alfredo Bayonne
1206-865-4027
1206-865-4037

110423 S E. 30th Place
Bellevue, WA

USA.

98006

|
Done |
2. Change some of the fields and click the Submit button.
You should see the confirmation page with the new values.
Ihttp:,l',l'lacahast:QDBDIwintlabxxicustDoUpdate.do j Cl«+= @ @“’9 = |
=
Update Complete
Customer Number: 0010100
Custormer Name: Meridien Electronics Limited
Representative Number: 43443
Contact: Alfredo Bayonne
Fhone Number: 206-865-4027
Fax Mumber. 206-865-4037
Address: 10423 S E. 30th Place
City: Bellevue, WA
Country: UsSA.
Zip: [U8006
Back to Custorner Inquiry
=~
—
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3. Click the Back to Customer List link and you will return to the customer list
page.

Recap

Congratulations! You have completed Module 6: Running the updated Web
application. You should know understand:

* How to restart the server
* How to test the updated Web application.

In this tutorial, you learned how easy it was to create a new input page to view a
list of customers (custList.jsp) and use an existing output page (result.jsp) to create
new output pages to update customer records and confirm updates were
completed on the iSeries (custDispUpdateResults.jsp and custDoUpdateResults.jsp)
for an existing e-business customer inquiry application. While you created these
pages, you learned how easy it was to use the iSeries wizards in Development
Studio Client to link pages together to form an application with multiple Web
interactions. You then learned how easy it was to run the updated customer
inquiry application in the WebSphere Test Environment that is part of
Development Studio Client.
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Appendix. Notices

Note to U.S. Government Users Restricted Rights — Use, duplication or disclosure
restricted by GSA ADP Schedule Contract with IBM Corp.

This information was developed for products and services offered in the U.S.A.
IBM may not offer the products, services, or features discussed in this document in
other countries. Consult your local IBM representative for information on the
products and services currently available in your area. Any reference to an IBM
product, program, or service is not intended to state or imply that only that IBM
product, program, or service may be used. Any functionally equivalent product,
program, or service that does not infringe any IBM intellectual property right may
be used instead. However, it is the user’s responsibility to evaluate and verify the
operation of any non-IBM product, program, or service.

IBM may have patents or pending patent applications covering subject matter
described in this document. The furnishing of this document does not give you
any license to these patents. You can send license inquiries, in writing, to:

IBM Director of Licensing
IBM Corporation

North Castle Drive
Armonk, NY 10504-1785
US.A.

For license inquiries regarding double-byte (DBCS) information, contact the IBM
Intellectual Property Department in your country or send inquiries, in writing, to:

IBM World Trade Asia Corporation
Licensing

2-31 Roppongi 3-chome, Minato-ku
Tokyo 106-0032, Japan

The following paragraph does not apply to the United Kingdom or any other
country where such provisions are inconsistent with local law:
INTERNATIONAL BUSINESS MACHINES CORPORATION PROVIDES THIS
PUBLICATION “AS IS” WITHOUT WARRANTY OF ANY KIND, EITHER
EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED
WARRANTIES OF NON-INFRINGEMENT, MERCHANTABILITY OR FITNESS
FOR A PARTICULAR PURPOSE. Some states do not allow disclaimer of express or
implied warranties in certain transactions, therefore, this statement may not apply
to you.

This information could include technical inaccuracies or typographical errors.
Changes are periodically made to the information herein; these changes will be
incorporated in new editions of the publication. IBM may make improvements
and/or changes in the product(s) and/or the program(s) described in this
publication at any time without notice.

Any references in this information to non-IBM Web sites are provided for
convenience only and do not in any manner serve as an endorsement of those Web
sites. The materials at those Web sites are not part of the materials for this IBM
product and use of those Web sites is at your own risk.
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IBM may use or distribute any of the information you supply in any way it
believes appropriate without incurring any obligation to you.

Licensees of this program who wish to have information about it for the purpose
of enabling: (i) the exchange of information between independently created
programs and other programs (including this one) and (ii) the mutual use of the
information which has been exchanged, should contact:

Lab Director

IBM Canada Ltd. Laboratory
8200 Warden Avenue
Markham, Ontario

Canada

L6G 1C7

Such information may be available, subject to appropriate terms and conditions,
including in some cases, payment of a fee.

The licensed program described in this information and all licensed material
available for it are provided by IBM under terms of the IBM Customer Agreement,
IBM International Program License Agreement, or any equivalent agreement
between us.

Information concerning non-IBM products was obtained from the suppliers of
those products, their published announcements or other publicly available sources.
IBM has not tested those products and cannot confirm the accuracy of
performance, compatibility or any other claims related to non-IBM products.
Questions on the capabilities of non-IBM products should be addressed to the
suppliers of those products.

This information contains examples of data and reports used in daily business
operations. To illustrate them as completely as possible, the examples include the
names of individuals, companies, brands, and products. All of these names are
fictitious and any similarity to the names and addresses used by an actual business
enterprise is entirely coincidental.

COPYRIGHT LICENSE:

Each copy or any portion of these sample programs or any derivative work, must
include a copyright notice as follows:

© (your company name) (year). Portions of this code are derived from IBM Corp.
Sample Programs. © Copyright IBM Corp. 1992, 2004. All rights reserved.

If you are viewing this information softcopy, the photographs and color
illustrations may not appear.

Programming interface information

Programming interface information is intended to help you create application
software using this program.

General-use programming interfaces allow you to write application software that
obtain the services of this program’s tools.
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However, this information may also contain diagnosis, modification, and tuning
information. Diagnosis, modification and tuning information is provided to help
you debug your application software.

Warning: Do not use this diagnosis, modification, and tuning information as a
programming interface because it is subject to change.

Trademarks

IBM
iSeries
WebSphere

Java and all Java-based trademarks and logos are trademarks or registered
trademarks of Sun Microsystems, Inc. in the United States, other countries, or both.

ActiveX, Microsoft, SourceSafe, Visual C++, Visual SourceSafe, Windows, Windows
NT®, Win32, Win32s and the Windows logo are trademarks of Microsoft
Corporation in the United States, other countries, or both.

UNIX® is a registered trademark of The Open Group.

Other company, product, and service names may be trademarks or service marks
of others.
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